Beyond XML

User Guide

All rights reserved. No parts of this work may be reproduced in any form or by any means; graphic,
electronic, or mechanical, including photocopying, recording, taping, or information storage and
retrieval systems, without the written permission of the publisher. Products that are referred to in
this document may be either trademarks and/or registered trademarks of the respective owners. The
publisher and the author make no claim to these trademarks.

While every precaution has been taken in the preparation of this document, the publisher and the
author assume no responsibility for errors or omissions, or for damages resulting from the use of
information contained in this document or from the use of programs and source code that may
accompany it. In no event shall the publisher and the author be liable for any loss of profit or any
other commercial damage caused or alleged to have been caused directly or indirectly by this
document.

Published: 2014

© 2014 Libra Ltd.



1.1.

4.1.
4.2.
4.3.
4.4.

5.1.
5.2.

TABLE OF CONTENTS

OVERVIEW .....oiiiiiiieiiiiiiiiiiiieeiisiiinssassssisssiisesssssssssssimsssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssnsssssss 3
[C1U | O S T TR U PRSP 3
CREATING AND EDITING XIVIL FILES.........ccoiitimmmunniiiiniiinennesiiesiimmssmssssissiiimssmssssssssimessssssssssssssssssssssssssssssssssssssss 4
COMPARE, MERGE AND UPDATE XML SCHEMAS. .......ccciiiivttiiisnneiiisneeiissneesissssessssssessssssessssssesssssssessssssessssns 5
DYNAMIC & FLEXIBLE XML FILTERING .......cccotttiiiiiiiiininiinnnniiniiiiiiiniiissiissississssssssmmmsmsssssssssssssssssssssssssssssssssssssnns 7
YTl T =1 o OO P U OP P RPRR PSR PSROPROPRORI 7
XML filter - Hide/Display properties in XIML trEES ........cccererirereeieierieriesieste st eeteeete e seesteseesaeeneeaensesseseeseens 8
STV T I =T o Ta Yoo oT=T =Y o] PR 10
BUIE-IN FIlt@IINEG CrItEIIA oottt sttt e bt e st e st e e st e sabeesaneeeas 10
SEARCH AND FIND ..ccoocoutiiiiieeiiiiiuteiiissstesiisseeiissssesssssssessssssessssssssssssssesssssssesssssssesssssssessssssesssssssesssssssasssssnns 12
(013 T=T o8 10 Te o] o1 d o] o -3 AN U T T OO P P PPTOPPIPPPRTON 12
SO N e, 12
LI 178 I T 13

10 N 14



Table of Contents

1. OVERVIEW

BeyondXML is a revolutionary innovative XML editor that offers a host of new and highly useful
features currently unavailable in other XML editors, making it the most powerful XML editor on the
market. BeyondXML's unique features save you time and result in a significant improvement in XML
quality and consistency.

Unlike existing text-based XML editors, BeyondXML boasts a new object-based GUI and offers an
easy and intuitive way of comparing and merging XML files, a broad range of dynamic & flexible XML
filtering and extensive statistics and reports capabilities.

1.1. GUI

1 Beyond XML
File Edit Options XML Tools Help
DEo WEW & ¢ » x 20
[y izl % ComparcFies x Statstics
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© L. encoding

Error Console

XML files can be displayed in two modes; as xml syntax or as an xml tree
schema. Use the respective button at the bottom left of the screen to toggle
between display modes.

The right pane displays statistics, including numbers of each component type in the document
and in the selected xml node, and statistical results of the last compare.

At the bottom of the right pane (under the statistics) there is an Error Console displaying
massages and notes.

Multiple documents are displayed in tabs (including comparison of two files).

In the comparison mode, color scheme enables fast spotting of the differences.
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Creating and editing XML files

2. CREATING AND EDITING XML FILES

1. Create a new XML by selecting New from the File menu or opening an existing file for editing.

When opening a document the default view is xml syntax text view. Use the respective button at the
bottom-left of the screen to toggle between Text and Tree view modes.

In Tree view:

2. Select a row and right-click to display a contextual menu with various options for building and
editing xml documents.

Name
= wml
= Jb school
- L pum
+" ;a; Insert P || o Element Ctrl+Shift+N
- hf Append b|lL  Attribute Ctrl+Shift+A
= ? pr AddChild v | [l Cdata Ctrl+Shift+B
? Delete Cerl+D | 1 Comment Ctrl+Shift+T
Copy Ctd=C | @ ext Ctrl+Shift+ X
Paste Ctrl+V
Undo Cirl=Z | 2  Processinglnstruction
Redo Ctd+y | mll

Insert: add elements, attributes, cData, comments to the selected element, as a child to the same
parent.

Append: Append elements, attributes, cData, or comments at the end of the nodes list of the same
ancestor node.

AddChild: add the xml component to the xml file as a child to the selected component.
Delete: delete the selected xml component.
All other functions will work as expected on the selected component.

3. Editing the text and value of a component: To edit the text and value of a component, click on
it and type (this will replace the existing text with the typed text). To edit the text without
replacing it click again to place the cursor in the text.

In order to maintain the integrity of the file, only components that are suitable for the type of selection
according to the XML logic are enabled. Other components are disabled.
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Compare, merge and update XML schemas

3. COMPARE, MERGE AND UPDATE XML SCHEMAS
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This unique capability - not available in any other XML editor - allows you to compare and merge
XML files quickly and intuitively, saving time and significantly improving XML quality and consistency.

1. Toggle to Compare mode by clicking on the Compare button [ in the toolbar or selecting the

Compare option from the Tools menu.

2.  Load files you want to compare/merge by clicking on the icon located under the toolbar at
the top-right corner of each pane.
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3. Al missing, different and identical lines and elements in both files will be clearly highlighted in
category-specific colors:
- missing lines and elements are displayed in blue;
- differences are displayed in red
- identical elements remain black.

4.  Expanding or collapsing an element in one file automatically expands or collapses the same
element in the other file, allowing you to arrange the workspace efficiently

5. Use the right-click contextual menu to move elements from one file to the other and/or delete
them. Alternatively, you can use the LTR and RTL buttons in the toolbar (LTR: adding what is in
the Right side to the Left side and RTL adding to the Left side what is on the Right side).
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Compare, merge and update XML schemas
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4. Save file as you work by clicking on the Save button located under the toolbar at the top-right

corner of each pane (next to the Open button). H|
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Filtering

4. DYNAMIC & FLEXIBLE XML FILTERING

BeyondXML offers extensive dynamic & flexible XML filtering capabilities using various filtering
criteria and built-in filtering operators. It allows you to customize filtering to your personal needs
and have extensive control over hiding and displaying elements and properties in XML trees.

4.1. SEARCH FIELD

1. Start typing criteria and watch immediate results as you type (only the XML tree branches
containing values that match your criteria are displayed).

2. Enhance your entered criteria with useful built-in tools (click on |:| in the Search field to open
a dropdown list of available search tools)

Type here to filter

| W
Ma
Maore...

|+ | Case sensitive
Caze insensitive
Uze wild cards
Use regular expression
« | Match from start
Match exactly
Match anywhere

v | Keep parent row if any of the children match

« | Keep the children if any of their ancestors match
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Filtering

4.2. XML FILTER - HIDE/DISPLAY PROPERTIES IN XML TREES

Create hide/display filtering rules by selecting elements and then determine what to hide/display
1. From the Tools menu, Select XML Filter.

2. Click on Add Row.

3. Select the desired elements and then the properties to display/hide.

Elements

= Ju License
i Id
- [¥] 4 Signature
- [ b ProductFeatures
- [ 4 Customer

Attributes ;[ Hide Al

Processing Instruction : Hide Al

Text [] Hide Al
Commennts : Hide Ak
Cdata : [ Hide Al
Xindude [| Hide Al
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Filtering

5.

Once you create filtering rules you can add rows, remove rows, and open a row for editing by
clicking on the appropriate button in the XML Filter dialog, or easily and flexibly edit a row by

clicking on the False/True of the desired property and changing it.

Hiding Configuration

Attribute Text
frue True

¥include
False

Processingl...

False

Hiding Configuration

Attribute Text Comment Cdata Xindude Processingl... Add Row
true True False Falze Falze o~
false False False False True False |  OpenRow
£| RemoveRow

A two-rule configuration
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Filtering

4.3. BUILT-IN FILTERING OPERATORS

Use common built-in filtering operators such as AND, OR, EQUAL/NOT EQUAL, LESS THAN/GREATER
THAN and many others to create customized queries.

The customized filtering option allows you to use various filtering operators for extensive and
precise filtering:

1. Click on the filtering icon at the top-right corner of the pane (in the Name bar — hover over it to

display it) :

2.  Select (Custom...) — the top item on the list

Marme
(all)
(Custom...)
name
xml
Signature
ProductFeatures
Customer
Licen1seID

! = = name

: “ ) Licen1selD

=~ 5% Customer

= i Mame
- eitan12 alim1alam12

6. Specify the condition and the value and click OK.

&y Custom Filter for “Name"@

Condition: Value(s):
isin v Egpature v ]
(] (Al

[ Iname (7
[ xml
[V]Signature I
[ |ProductFeatures
[ Customer

["|Licen1seID 44

[ OK ][ Cancel ]

[ »

4.4. BUILT-IN FILTERING CRITERIA

1. Click on the filtering icon at the top-right corner of the pane (in the Name bar — hover over it to
display it) :
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Filtering

QuickTableFilterField

| Q- Type here to filter

Mame
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-
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= L name
_ - @ Licen 1seID
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=- 4 Name
i eitan12 alim1alam12

2.  Select the desired criteria from the list
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Reports

5. SEARCH AND FIND

The Search and Find mechanism is located at the bottom of the main text window.

E Find: bo (&) Find Next (2 Find Previous [[=| Highlight

Match Case || Whole Words

As you enter text in the Find field matching text will be displayed. Click on Highlight to have
matching text highlighted as you type.

If there is no match, the message Phrase not found is displayed.

B Fnd: _ (& Find Next (2 Find Previous [l Highlight [£] Match Case [] Whole Words A4 Phrase not found

5.1. OTHER FIND OPTIONS
Find Next Highlight the next match
Find Previous Highlight the previous match
Highlight Highlight all the matching entries
Match Case  Takes capital letters into consideration

Whole Word  Highlight only if a complete word matches

5.2. SORTING

Click on the header above the elements list (name) to sort the element in ascending or descending
order.
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Reports

6. XML STATISTICS

BeyondXML is the only XML editor that offers extensive segmented statistics including the number
of Nodes, Attributes, Elements, Cdata text, Processing Instruction and Deep at both the file and the
node level, as well as statistics of the last compare results.

The Statistics pane is always displayed on the right of the screen by default. You can use the display
functions of the Statistics pane to float the pane, auto-hide/display it, and close it

The statistics screen is arranged in three segments that can be collapsed and expanded:
All file statistics, XML Node statistics, and statistics of the last file compare action you performed.

Statistics [EJE T ¢
All File Statistics =
Modes 185
Attributes 24
Elements 77
Cdata 0
Text =]
Proccessing Instruction 1]
Comment 5
Deep 5
XML Mode Statistic »
Modes 1]
Attributes 1]
Elements 1]
Cdata 0
Text 0
Proccessing Instruction 1]
Comment 0
Deep 0
Compare File Statistic »
Type Missing Diffrencess Equal
Element 57 22 7 o~
Attribute g 4 0 b
Cdata 4 0 1 |
Comment 1 0 ] T
ProcessingInstruc,.. 0 0 0 o
Kinclude a 0 ] il
Error Console s
Premature end of file
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Reports

7. REPORTS

BeyondXML offers a ‘reports’ function summarizing the results of files comparison and showing

extensive details of missing and different elements and attributes.

1. Select Report for the Tools menu in the compared file

2. Chose the location for saving the report and click on Generate report. The report will be saved in
HTML format in a folder named BeyondXML Reports.

3. Double-click on the report to display it in your default browser.

Beyond XML Report

Details Report for Comparison Cardigan-Cat_Cardigan-Catalog Files

Description

Total number of equal
Elements

Total mumber of
differences Elements

Total number of missmg
Elements

Total number of equal
Attributes

Total number of
differences Attnibutes

Total number of missmg
Attributes

Total number of equal
Cdata

Total number of
differences Cdata

Total number of missmg
Cdata

Element Comparison:

Left

Ja xml
He L version

- g catalog

Number Of | Description Number Of

Fields

=1

(=1

[=1

[=1

[=1

Fields

Total number of equal Text
Total mumber of differences Text |0

Total number of nussmg Text 10

Total number of equal Comments |0

[=1

Total mumber of differences
Comments

Total number of missmg 3
Comments

[=1

Total number of equal
Processmginstruction

[=1

Total mumber of differences
Processmglnstruction

[=1

Total number of missmg
Processmglnstruction

Right

g mml

+ VEersion
Catalog Winter 2015
+- g catalog

-

The elements in the Element Comparison section are displayed. The various nodes can dynamically be
expanded or collapsed by clicking the ‘+’ of the relevant node on the html report.

In the below screenshot, you can see the same Report with deeper levels of detail.
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Reports

Element Comparison:

Right

il mml

version

El- i catalog
Bl product

#- _ description
t-, product_image
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F- il price
H-gi size
*- 1, size

#-0 cataleg_itermn
e

Jb item_number

version
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B product
L. description
. product_image
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Jla price
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Comment

----- I comment
-0 cataleg_item
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Ui item_number
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